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° software is a program for designing the heads of violins, violas, and cellos. The design prin-
I l l 1 S ciples of string instrument heads are very complex, making it difficult to draw them precisely
using only a compass and ruler. In particular, modifying shapes in detail while maintaining

basic principles is even more challenging, making it virtually impossible to achieve a high-quality head design through

manual work alone.

This software was developed to resolve the limitations and inconveniences of traditional head design methods, such as
the presence of discontinuities and the difficulty of the design process. Makers can use this program to design their own
original models or to precisely copy and modify existing models. When copying existing models, it does not simply trace

the outline of a photo; instead, it generates curves based on mathematical models, allowing for perfectly smooth curves.

A modified logarithmic spiral is used for the scroll design, and clothoid curves are applied to the pegbox design. You
can freely create desired curve shapes by adjusting just a few parameters. It also includes safety features to help prevent

accidental violations of essential rules in head design.

Chin designs for violas and cellos can be fully implemented, and instrument-specific presets make the work fast and
convenient. The completed design is saved as a general-purpose CAD file, which can be used to create templates. The
accompanying text file records detailed data, useful for design analysis. Additionally, the import/export function allows

previously worked designs to be loaded and executed immediately.
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1.1

1.2

1.3

Software Features

L]

Design

Automatic design using modified logarithmic spirals and multi-clothoid curves

Selection of display items (layers) for the resulting design
Selection of update methods for the resulting design
Function to display reference instrument images

Import and export of setting values

Initial values provided for each instrument (presets)

Output

Screen output of the resulting design
PDF file output of the resulting design
DXEF file output of the resulting design

TXT file output of numerical values of the resulting design

Analysis

Display of parameter values used in the design
Display of numerical values for each part

Display of proportional values for each part
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2 Installation

This software is a portable version, so no separate installation is required. Simply unzip the file and double-click the ’Vio-
lin_Head_Designer_v.X.X.X.exe” file to run the program immediately. Note that it may take some time to start depending

on your computer’s specifications.

Please note the following when running the program:

B Run as Administrator

If the ”Violin_Head_Designer_v.X.X.X” folder is located in a Windows system folder such as "Program Files” on the C
drive, you must [Run as administrator] when launching the program. Otherwise, it may not function properly, or files such

as PDF, DXF, and TXT might not be saved correctly.

B Windows Security Settings

When unzipping the program files, Windows Security may automatically delete some files, identifying them as suspicious.
In such cases, you must restore the files from quarantine in the Windows Security settings and then unzip them again. This

software does not contain any viruses.
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3 Operating Principles

3.1 Control Points and Reference Points

This program generates curves or determines the positions of reference points based on control points. There are four

control points (Points O, S, T, and Z), and the user enters the coordinates directly. The end of the fingerboard (Point O) is

set as the origin (0, 0), and the center of the scroll eye (Point S) serves as the starting point for all curve designs, including

the scroll and the pegbox. Additionally, the pegbox tail end (Point T) and the thinnest point of the neck (Point Z) are used

as control points.

Reference points refer to points other than the four control points mentioned above, and their positions are determined

by the locations of the control points and various parameter settings. Reference points are defined and entered through

distances or angles relative to other points.

Logarithmic spirals and multi-clothoid curves are used for the scroll design, while multi-clothoid curves are used for the

pegbox. To implement various scroll shapes, a modified formula of the basic logarithmic spiral was applied. A multi-

clothoid curve is a curve that smoothly connects three clothoid curves using G2 Hermite interpolation into a single path.

Figure 1: Control points (red) and reference points (other colors)
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3.2 Logarithmic Spiral

A logarithmic spiral is a spiral where the angle between the tangent at any point and the radial line from the pole (center
point) is constant. Due to this constant angle, the distance from the pole increases geometrically as you move along the
spiral. In other words, the radius grows by a constant ratio with each full rotation. In nature, a cross-section of a nautilus

shell is a representative example.

(a) Logarithmic spiral (b) Cross-section of a nautilus shell

Figure 2: Logarithmic spiral and nautilus

Mathematically, it is expressed as follows and can be regarded as the basic form of a violin scroll.

z(0) =a- e cos
(H
y(0) = a-e*¥sinf
a: Initial radius (length of the radial line when 6=0)

0: Rotation angle (radians)

k : Growth rate of the spiral (positive for outward, negative for inward)

However, actual violin scrolls differ slightly from standard logarithmic spirals. Therefore, the existing formula must be
modified to implement a curve closer to the real object. The following section describes the modified logarithmic spiral

used in this program.
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3.3 Modified Logarithmic Spiral

This program uses a modified version of the logarithmic spiral formula to accommodate various violin scroll shapes. By
subdividing the exponent (k) of the standard logarithmic spiral formula into «, 3,y, § as shown in the following equation,

various types of spiral curves are precisely implemented.

8 2

2(0) =a-e*?"+70H90% co50
) , @)

y(0) =a-e®0 +70+30 ging

a: Initial radius (length of the radial line when 6=0)

0: Rotation angle (radians)

« : Exponential coefficient (curvature)

B : Exponential power (change rate)

~ : Linear correction term coefficient

¢ : Quadratic correction term coefficient

The figure below shows a comparison where the sizes (radii) of the innermost first scroll and the outermost third scroll are
fixed, while only the size of the second scroll is changed. In the figure, it can be observed that A, B, and C are maintained,

while only D is changed.

v

@ A
Figure 3: Comparison of two curves drawn with modified logarithmic spirals

Although the shape of the modified logarithmic spiral is determined by four parameters (o, 3,7, d), it is very difficult
for a user to set these values directly. Therefore, when the user simply inputs the radii of the three scrolls, the program

automatically finds the optimal parameters and generates the curve.
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3.4 Clothoid Curve

A clothoid curve refers to a curve where the curvature increases as the length of the curve increases. In other words, it is

a curve that curls more tightly as the curvature gradually increases. - Figure.4 (a) -

Since such a clothoid curve matches the trajectory of a car moving at a constant speed while its steering wheel is turned
at a constant rate, it is primarily used as a transition curve for highway bends. The red line in Figure 4(b) is the clothoid
curve. Using a highway as an example, when transitioning from a blue straight road to a green circular road, the turning

radius is gradually reduced along the clothoid curve.

0.10 4

0.05 A

0.00 4

—0.05

—0.10 A

T T T
-0.15 -0.10 -0.05 0.00 0.05 0.10 0.15

(a) Clothoid curve (b) Clothoid curve on a highway

Figure 4: Clothoid curve
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3.5 Multi-clothoid Curve

When connecting two control points at fixed positions with a clothoid curve, if the directions of the curve at those two
points do not change, only one unique clothoid curve can exist to connect them. This poses a significant problem in violin
design because it would mean only one design could be created for a specific instrument size (where control point positions

are fixed).

Figure.5(a) shows a single clothoid curve connecting points A and B. This curve’s shape will never change unless the
directions at points A and B are altered. Figure.5(b) shows points A and B connected by a multi-clothoid curve, where
only the curvature is changed while maintaining the same direction at points A and B. As seen in the figure, an infinite
number of curve shapes can be generated. In other words, using multi-clothoid curves allows for the creation of various

shapes without changing the positions of the control points or the directions of the curve.
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(a) Single clothoid curve (b) Multi-clothoid curve

Figure 5: Single clothoid and multi-clothoid curves

The multi-clothoid curve mentioned in this document refers to a single curve formed by joining three single clothoid curves

using a method called ”G2 Hermite Interpolation.”
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3.6 Changing the Shape of Multi-clothoid Curves

When two points are connected by a multi-clothoid curve, the shape of the curve is determined by the “direction” and

“curvature” of the multi-clothoid curve at each point.

W Direction

The shape of the curve changes according to the direction it faces (angle, East = 0°). Figure.6 shows the shapes of multi-
clothoid curves with different directions at the starting and ending points. The left image shows the curve starting toward
the 272°direction, while the center image shows it starting toward the 300°direction. The right image shows a case where
the direction at the destination point is different. Note that the direction of the curve is always ’based on the direction of
travel.” In the center image, the direction of the curve at destination point B is 231°, and in the right image, the direction

is 200°.

Figure 6: Changes in the shape of a multi-clothoid curve according to curve direction
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H Curvature (Magnitude and Sign)

Curvature is a value that determines the degree of bending in a curve. A larger absolute value of curvature (meaning a
smaller radius of curvature) results in a sharper bend, while a smaller value results in a gradual bend. Additionally, the +/-
sign determines the direction of the bend. When the sign of curvature is positive (+), the curve bends to the left relative to

the direction of travel; when the sign is negative (-), it bends to the right.

Figure.7 shows how the curve changes when the starting direction at point A remains the same, but the magnitude and sign
of the curvature are varied. The left image shows the case where the curvature is -100; since the sign is negative, it bends
to the right relative to the direction of travel, and because the absolute value is large, it bends sharply. In contrast, the right
image shows the curve with a curvature of +100; since the sign is positive and the absolute value is large, it bends sharply
to the left. The center image shows the case where the curvature is 0, extending straight in the direction of travel without

any bending.

Curvature=-100 Curvature=0 Curvture=+100
A A A

)\ \ \

./ ‘/ ‘/ ’
B B B

Figure 7: Changes in the shape of a multi-clothoid curve according to the sign and absolute value of curvature
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3.7 Curve Names and Locations

This program assigns unique names to the curves and straight lines used in the head. The names are as follows and are

used identically in the layer panel. (Names in the layer panel are indicated in bold.)

Main Mid Sub

Segment

Curve Type

Description

Scroll

S1—-S12

Scroll Curve

Extended Scroll

S12—

Modified
Logarithmic
Spiral

Spiral curve from point S1 (start) to S12 (end).

A virtual extension curve of the Scroll, rotating half a
turn from S12. Used as a reference line for comparison

with the Outer Lower.

Inner Upper

S16—S19

Circular Arc

An arc that perfectly overlaps the Inner Guide; it is the
virtual upward extension of the front pegbox curve. It
circles above the Scroll and meets it at the front. It
serves as the boundary line between the flat horizontal
surface of the pegbox and the sloped surface that

gradually forms as it enters the Scroll.

Inner Curve

Inner Connector

Inner Lower

S16—S18

Inner Hook

S17—S18

Inner Bottom

S18—Y

Multi-clothoid

The Inner Connector and Inner Bottom form a single
curve (multi-clothoid) and are separated only
conceptually. The Inner Connector is the starting section
of the Inner Lower, and its end coincides with the end of
the Inner Hook. (It branches upward from the starting
point of the Inner Bottom into the Inner Connector and

Inner Hook.)

The connecting curve joining the Inner Bottom and the

Scroll; the part used for hanging the instrument.

The main curve of the front part of the pegbox, located

below the Inner Connector.

Inner Base

Y—Cl1

Straight Line

The straight section below the Inner Lower; some

instruments may not have this section.

Inner Guide

oS, S-S16

Circle

A reference line for determining the Inner Upper and
Lower. The Inner Curve is divided into Upper and Lower

at point S16 on the Inner Guide.

Outer Upper

Outer Curve

S12—S14

Multi-clothoid

A curve that rotates half a turn across the top from the
frontmost point (S12) to the rearmost point (S14) of the
Scroll. Unlike the logarithmic Scroll, it is drawn as a

clothoid curve.

Outer Lower

S14—=T

Multi-clothoid

The curve of the back of the pegbox, continuing down

from the Outer Upper.

Outer Guide

S12—

Single Clothoid

A pure single clothoid curve used as a reference when

creating Outer Upper/Lower curves.

Table 1: Names and descriptions of curves
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Scroll Curve Extended Scroll
s12 5
G
Scroll
Inner Upper Inner Upper Inner Guide

519

519 <16
Inner
518 Connector
+

Inner Curve Inner Bottom

-

Inner Lower

Inner Base

Outer Upper

OQuter Curve Outer Guide

Figure 8: Names and locations of curves
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4 Screen Layout and Feature Description

4.1 Main Window

The [Main Window] is divided into five areas, each serving the following functions:

Area (A): Drawing name settings, preset application buttons, and descriptive images for control and reference points.

Area (B): Instrument size settings for creating the drawing.

Area (C): Curve shape settings.

Area (D): Selection of items to be displayed on the created drawing.

Area (E): Buttons for drawing the diagram and saving files.

# Violin Head Designer = [m} X
File Tools Hel

Instrument | | seron (s1->s12) | | outer Guide (S12-5Gb-») M % Point
& Violin © cello U. Eye Angle (1) Clothoid Scale - ¥ Point Name
PRESET € Viola (cheekX) C Viola (cheek 0) 1* 5cl. Radius (5-52) (AR ‘ K Scrol)
o R - I Extended Scroll
| | W setaxes |l 2" scl Radius (5-58) ctntangle — Pl
3° Scl. Radius (5§10 :
@ Auto & WAL el Radus (510 Start Cunvature I Inner Upper
Delete All Values Axes X (min ~ max) 20~ 60 17 Resuit = End Angle T ¥ Inner Connector
Axes Y (min ~ max) =30~ 120 2° Result = Y — W Inner Hook
DIAGRAM S ‘ 3" Result = W Inner Bottom |
Outer Lower (S14-T] IV InnerBase
A—r B @ Auto ' Use My Value [Inner Upper (S16->519) | | : L ‘ i
“ . o - Start Angle 2700 I™ Outer Guide
(1~10) * Y(1~20) = 10 V. Radius (5-516)
B — Start Curvature I4 Outer Upper
e E Coordinate & Parameter | V-Andle 516) End Angle ¥ Outer Lower
— {’w 2 S\ v 0 - Position (x, y) 00, 00| M| mner Lower (S16-Y) | e F;Es BD:GLTE
b v . eg Fosition
S‘(x,y‘g; s16¢ 0w ff S-Poston ey ‘ ' Start Angle I~ Center Line
519 — s ¥ T - Position (x.y) Start Curvature ‘ e Hook|S1ZEST8) ‘ T
N N End Angle
-

End Curvature

‘_,l‘ / C. Head Margin ‘ o . ::)h::nfgr
S /AN ey
c e E. NutThickness - | Point Position | [ PegPosition |J T cutting Line
A’J\k\\i\\, Ar;@_r F. Nut Helght ‘ 514 (along the y-Axis) * along the centerline normal : I™ Other Guide
. A H G. Peg Hole Diameter \ G17 (slongthecurve) | 1st Hole I~ Reference Image
l, Nt 1" H. Peg Box Thickness 518 (along the curve) 2nd Hole [
0(0,0) T\ I. Upper Peg Margin ‘ 3rd Hole
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Figure 9: Main Window
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4.1.1 Basic Settings
B MODEL NAME

Enter the name of the drawing you are creating. The text entered here will be recorded in the [Result Window] and all

saved files.

B PRESET

The preset function is provided for user convenience; clicking the desired instrument button automatically fills all input
fields with initial values. To clear all entered values, click the [Delete All Value] button. Violas are divided into models
with and without a chin. It is efficient to input all values using the preset button first and then modify only the necessary

parts.

Presets are designed based on the models below. However, due to distortions in the reference instrument photos, they may
not perfectly match the actual dimensions of the instruments. Generally, head photos are taken with the focus on the center
of the scroll, so distortion increases further from the focus. Consequently, the position of the lower pegbox or peg holes
may differ slightly from the actual model. Even if the original model does not have a head margin, it has been applied to

all presets.

% Instrument models for PRESET

¢ Violin: Stradivari, Violin, 1677 “Sunrise”

¢ Viola (No chin): Stradivari, Viola, 1734 “Gibson”

¢ Viola (With chin): Stradivari, Viola, 1672 “Mahler”
¢ Cello: Stradivari, Cello, 1732 “Stuart”

H DIAGRAM

You can check the positions of control points and reference points, as well as the areas indicated by the input items.
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4.1.2 Size Settings
B GEOMETRY » Instrument

Select the instrument to design: violin, viola, or cello. This option is used to automatically set the axis ranges for the [Result

Window] and the PDF file graphs. Violas are divided into two models based on whether they include a chin design.

B GEOMETRY ) Set Axes

Sets the range of the horizontal and vertical axes to be displayed in the [Result Window]. Selecting [Auto] automatically
sets the axis range according to the instrument size. To set it manually, select [Use My Value] and enter the minimum and
maximum values for the X and Y axes in the input fields below. The unit is [mm]. For example, if the vertical length of
the head is 106mm, the minimum Y-axis value should be less than 0 and the maximum value greater than 106 to ensure

the entire curve is not cut off.

B GEOMETRY > Set Canvas Size

Sets the canvas size of the [Result Window], which should consider the user’s monitor resolution. A canvas size value of
’1” corresponds to a resolution of 100 dpi. For example, if the monitor resolution is [1024 * 768], the maximum canvas

size can be approximately [10 * 7.7].

The setting method can be chosen between [Auto] and [Use My Value]. If [Auto] is selected, it is set to 6 for width and
10 for height. Since the aspect ratio of the head does not vary significantly between instruments, the [Auto] setting is

recommended. Use the manual setting only if the monitor resolution is low.

B GEOMETRY » Coordinate & Parameter

Determines the overall size and shape of the head by entering the four control points (O, S, T, Z) and the dimensions of
each part. Enter the desired values referring to the DIAGRAM image. Among the control points, S, T, and Z (excluding the
origin O) must have XY coordinate values entered. Note that these must be relative coordinate values based on the origin
(0, 0), which is the end of the fingerboard. (It is more convenient to enter values collectively using the preset function and

then modify them.)

* S - Position (x,y): It is difficult to identify the exact rotation center point S of the scroll by eye. Therefore, you should
specify an approximate position first and then fine-tune it while setting the curves to find the optimal location.

T - Position (x,y): The pegbox tail point T refers to a virtual, perfectly sharp point before the edges are processed.
Since it is difficult to identify on an actual instrument, set it to the point where the upper and lower curves are
expected to intersect and then modify the position while drawing the curves.

* Z - Position (x,y): This is the thinnest point of the neck and the point where the neck curve ends. Since the program
generates the neck curve based on this point, the neck curve changes according to the position of Z.

* A. Eye Front: The distance from the scroll center to the front end. A warning message is displayed if the front end
of the scroll (Point S12) extends further forward than Point C1. This is a safety feature to prevent the scroll from

being damaged by planing during fingerboard replacement or joint work.
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B. Eye Back: The distance from the scroll center to the back end. In the case of antique instruments, the back end

of the scroll is often heavily worn, so this needs to be considered in advance.

* C. Head Margin: (or Fingerboard Margin), it is recommended to set an appropriate value considering fingerboard
repair or projection adjustments.

* D.Bottom Margin: The straight section of the pegbox. The length of this section may need to be adjusted depending
on the degree of bending of the pegbox curve.

e E/F.Nut...: While the size and shape of the nut do not directly affect the design, the arc formed by the nut’s thickness
and height is used when determining the peg hole positions, so it is best to enter these as accurately as possible.

* G. Peg Hole Diameter: If the peg hole position is inappropriate, the string may touch the inner wall of the pegbox.
To prevent this, enter the exact diameter value. Since the string wound on the second peg (H2') is most likely to
touch the inner wall, measure and enter the maximum diameter (inside the pegbox) of that area.

* H. Peg Box Thickness: A value used to determine in advance if the string touches the inner wall of the pegbox. The
actual thickness of the back of the pegbox becomes thinner than the input value due to fluting (Dorso) work. For
violins, where the fluting depth is about 2—-3 mm, it is recommended to set this value to at least 4 mm.

1. Upper Peg Margin: The Y-axis distance between the center point of the topmost peg and the bottommost part of
the scroll.

¢ J. Lower Peg Margin: The Y-axis distance between the center point of the bottommost peg and the end of the
fingerboard (origin).

¢ K:L:M. Spacing Ratio: The spacing ratio between the four pegs. It is common to set K and M at both ends
identically and set L in the middle slightly larger.

e N. Chin Margin: The chin of a cello or viola usually starts at the end of the fingerboard. However, some viola
models (e.g., Stradivari, Viola, 1727 “Cassavetti”’) have a “T-shaped” nut, so the chin starts at the midpoint of the
nut rather than the fingerboard end. When designing such models, enter an appropriate value; otherwise, enter ‘0’.

 P. Chin Angle: Enter the corresponding angle if you wish to adjust the slant of the chin line.

* Q. Chamfer Width: The width of the cross-section when the edges are processed.

¢ R. Chamfer Radius: Automatically calculates and shows the amount to be shaved off from point T to achieve the

set [Q. Chamfer Width]. (No manual input required)

I As the order of strings for violin and cello is reversed, this program refers to the pegs as 1, 2, 3, and 4 in order starting from the topmost peg (H1,
H2, H3, H4).
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4.1.3 Curve Settings
B CURVES > Scroll (S1-S12)

In this program, the Scroll refers to the spiral curve extending from point S1 to S12. After entering the [Coordinate
& Parameter] values, it is recommended to define the shape of the Scroll first, as both the Inner and Outer Curves are

influenced by it.

* U. Eye Angle: Enter the angle formed by the starting point S1 of the Scroll. Since it is located at the center of the

scroll, it is a crucial factor that determines the overall impression.

Figure 10: Angle of the scroll eye

* 1/2/3° Scl. Radius (...): Enter the three radii within the Scroll. The shape of the Scroll is determined by these
three parameters and the [A. Eye Front] value. While you can adjust the size of the internal curves individually
using multiple parameters, the nature of a logarithmic spiral limits the ability to control each radius completely
independently. If a value that makes spiral generation impossible is entered, a warning message will appear, and a
curve closest to the input values will be automatically generated. This process involves an “optimization calculation”
to find the best curve, which may take a few seconds.

[«— AEye Front—r«——3°—>
«—2°>

— 1%
T

Figure 11: Four parameters for the Scroll

* 1/2/3° Result: This represents the actual dimensions of the design displayed in the [Result Window]. For typical

scroll shapes, the results will match the input values. However, if the optimization calculation fails, the curve closest
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to the input values is generated, and its actual dimensions are displayed here.

[ scron(s1-512) | [scroll(s1-+512) | B
U. Eye Angle (51) 70 U. Eye Angle (51) 70 ? Warning X
1° Scl. Radius (5-52) 3 1° Scl. Radius (5-52) 2 |
2° Scl. Radius (3-56) 7.00 2° Scl. Radius (3-56) 7.00 seroll auto-fit did not converge.
- ; . - ) . The target radius values may be difficult to achieve.
3° 8cl. Radius (S-510) 3.00 3° Sl. Radius (8-S10] 3.00 " Plesse Ty aqjusting 1+/2+/3- scl Radius
1° Result 3.00 1° Result 210
2° Result 7.00 2° Result 6.89
=0
3° Result 13.00 3° Result 13.08
(a) Successful optimization (b) Failed optimization (¢) Warning message for failed optimization

Figure 12: Success and failure of optimization calculations

B CURVES > Inner Upper (S16-S19)

It is recommended to proceed with the design in the following order: Scroll Curve > Outer Curve > Inner Curve.> The
Inner Upper curve is a circular arc extending from point S16 (start) to S19 (end), and it perfectly matches the Inner Guide
circle. Since the arc is drawn counter-clockwise, S16 serves as the starting point. This is a virtual curve that is not actually

visible; it follows the Inner Lower curve upward and ends at the point (S19) where it meets the Outer Upper or Scroll curve.

As the horizontal surface of the pegbox approaches the Scroll area, it gradually slants and turns into a sloped surface. The
Inner Upper curve acts as the boundary between the horizontal and sloped surfaces. Therefore, if the radius of this arc is
large, it meets the Outer Upper or Scroll curve earlier, causing S19 to move up. If the radius is small, it meets later, causing

S19 to move down.

The center of the Inner Upper arc is point S, and the radius is the distance between points S and S16. Thus, the shape of
the Inner Upper is determined by the position of S16, which serves as the junction connecting the Inner Upper and Lower
curves. A smaller radius (S and S16 closer together) results in a thicker throat area of the pegbox, while a larger radius

results in a thinner throat.

The position of S16 is specified in the polar coordinate system, defined by the distance from point S (V. Radius) and the
angle relative to the horizontal line (W. Angle). Since S16 is the connection point between the two curves, the curvatures
of the Inner Upper and Lower must be similar at this point to ensure a smooth transition. If the position of S16 is inap-
propriate, it will be difficult to achieve a natural curve regardless of how much you change the Inner Lower settings. The
principle of the Inner Lower (multi-clothoid curve) transitioning into the Inner Upper (arc) is similar to Figure.4(b). It is

easier to determine the position of S16 by imagining the smooth flow of a straight road entering a circular road.

On most instruments, S16 is located near the midpoint of the line connecting point S and S14 (the apex of the Outer Curve
and the intersection of the upper and lower curves). Utilizing this rule allows you to estimate both the radius and angle

simultaneously, providing a good starting point for determining the position of S16.

2This is because the position of S14, which is the junction of the Outer Upper/Lower curves, can affect the Inner Curve.

J6 H.LS. Violin Atelier, Manual, April 2026 Page 18 of 34



Violin Head Designer, v.1.0.0 User Manual

Inclined Surface

Inner Upper Horizontal Surface

Outer Upper

Outer Lower

Figure 13: Role of the Inner Upper and determining the position of point S16

¢ V. Radius: The distance between points S and S16, which becomes the radius of the Inner Upper and Inner Guide.

* W. Angle (S16): The angle of the line 5516 relative to the horizontal line passing through point S.

% Regarding the types of curves used for the Inner Upper

This program uses a circular arc (Circle) for the Inner Upper curve and clothoid curves for the Inner Lower curve. Some
studies design this by placing two clothoid curves of different scales in opposite directions instead of a circular arc (in
which case the two curves connect at a midpoint of the Inner Lower). Using clothoids for the Inner Upper in this manner

causes the end of the curve to meet the Scroll at point S8 or S9.

In contrast, this program applies a circular arc to the Inner Upper, so the end of the curve meets the Outer Upper or the
Scroll. This method has the advantage of clearly defining the boundary between the horizontal surface of the pegbox and
the sloped surface of the Scroll. The debate over whether the Inner Upper curve is a circular arc or a clothoid exists because
this line is actually a virtual curve that is not visible. However, a circular arc is considered more appropriate for explaining

the boundary between the horizontal pegbox surface and the scroll slope.

B CURVES > Inner Lower (S16-Y)

The Inner Lower curve is a multi-clothoid curve extending from S16 to Y. To ensure that the two curves connect smoothly
without any points of discontinuity at S16, their directions and curvatures must match.®> While the curvature can be ad-
justed to achieve the desired shape, the direction must be strictly maintained. Therefore, the program automatically sets
and fixes the starting direction based on the arc curvature at S16. Additionally, the direction of the end point Y is fixed at
270° (vertically downward). The user shapes the curve by adjusting only the curvatures at the start point (S16) and end

point (Y) while keeping these two directions fixed.

3The actual direction will be 180° opposite.
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If you cannot achieve a satisfactory shape with these parameters alone, try adjusting the Inner Base value or changing the

position of S16 itself.

e Start Angle: Fixed value (automatic); the direction (angle) of the curve (arc) at the starting point S16 + 7.

Start Curvature: Curvature at the start point S16.
¢ End Angle: Fixed value, 270°.

* End Curvature: Curvature at the end point Y.

% Inner Guide Curve
The Inner Guide is a circle with the same center and radius as the Inner Upper. The Inner Upper is constructed based on

this Inner Guide.

B CURVES > Inner Hook (S17-S18)

The Inner Hook is a multi-clothoid curve connecting the Scroll and the Inner Lower. The point where it meets the Scroll

is defined as S17, and the point where it meets the Inner Lower is defined as S18.

Conceptually, the Inner Lower is divided into the Inner Bottom (below S18 down to Y) and the Inner Connector (above S18
up to S16). Since the Inner Connector is a virtual curve that is not actually visible, it is given a distinct name to separate

it clearly.

The default position for S17 is at the midpoint height between S3 and S7, while S18 is located at the same height as S11.

The positions of these points can be fine-tuned in the [ADJUST] panel.

S11 /7 s18

Figure 14: Default positions of points S17 and S18

 Start Angle: Direction at the starting point.
« Start Curvature: Curvature at the starting point.
* End Angle: Direction at the end point.

* End Curvature: Curvature at the end point.

B CURVES » Outer Guide (S12-Gb-)

The Outer Guide is a single clothoid curve used as a baseline or reference when creating the Outer Upper and Outer Lower

curves. As a pure clothoid curve, its shape is exceptionally smooth. By comparing your designed Outer Curve with this
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guide, you can easily identify the characteristics of your current design.

The end point of the Outer Guide is S12, and the start point is located on the Y-axis line of S12. Since it is a single clothoid,
the shape itself cannot be changed; only the Scale can be adjusted. The size is automatically calculated based on the [A.

Eye Front] and [B. Eye Back] values, and the point protruding furthest to the rear on the curve is defined as Gb.

Point Gb serves as the default position for S14, the connection point between the Outer Upper and Outer Lower. In the
case of the Outer Upper, a curve that perfectly matches the Outer Guide can be obtained by appropriately adjusting the

curvature of the start and end points.

* Clothoid Scale: The size value of the curve, calculated automatically.

B CURVES > Outer Upper (S12-S14)

The Outer Upper is a multi-clothoid curve connecting the frontmost point of the Scroll (start point S12) and the rearmost
point of the head (end point S14). The start point S12 is determined by the [A. Eye Front] and Scroll parameters, while the
end point S14 uses point Gb of the Outer Guide as its default value.* Unless adjusted separately, S14 and Gb will overlap

at the same position.

The directions of the start and end points of this curve are fixed vertically (90°, 270°), so only the curvature can be modified.
Although the shape can be changed by adjusting the curvature at these two points, there are limits to how much the shape
can be altered if the position of S14 remains fixed. The position of S14 is adjusted vertically in the [ADJUST] panel, while
horizontal movement is set via the [B. Eye Back] value. Changing [B. Eye Back] will modify the Outer Guide as well, but
moving S14 only vertically in the [ADJUST] panel will change the shape of the Outer Upper/Lower curves while keeping
the Outer Guide unchanged.

e Start Angle: Fixed value, 90°
« Start Curvature: Curvature at the start point

End Angle: Fixed value, 270°

* End Curvature: Curvature at the end point

B CURVES » Outer Lower (S14-T)

The Outer Lower is a multi-clothoid curve connecting the rearmost point of the head (start point S14) and the tail end (end
point T). Since the direction at the start point S14 is fixed vertically, the shape is created by adjusting only the remaining

three parameters.

Start Angle: Fixed value, 270°

Start Curvature: Curvature at the start point
* End Angle: Direction at the end point

¢ End Curvature: Curvature at the end point

4The position of point Gb is automatically determined by the [B. Eye Back] value.
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4.1.4 Curve Adjustment
B ADJUST > Point Position

As previously described, the positions of certain points can be adjusted here.

Note that S14 moves only vertically along the Y-axis, while S17 and S18 move along the trajectories of their respective

curves.
S14
/
/ /
Figure 15: Adjustment of positions for points S14, S17, and S18
¢ S14 (along the y-Axis): Moves S14 along the Y-axis. ‘+’ moves it up, and ‘-> moves it down.

i

* S17 (along the curve): Moves S17 along the trajectory of the Scroll curve. ‘+’ moves it upward, and ‘-> moves it
downward.
* S18 (along the curve): Moves S18 along the trajectory of the Inner Lower curve. ‘+’ moves it upward, and ‘-’

moves it downward.

B ADJUST > Peg Position

The positions of the peg holes are automatically calculated to satisfy the [I. Upper Peg Margin], [J. Lower Peg Margin], and

[K:L:M Spacing Ratio] values while being placed on the Center Line between the Inner Lower and Outer Lower curves.

Nt/
/\’y +

Y /
EN /

%/

Center Line\ ¥ S/

/
<+ /
/

Figure 16: Center Line and Peg Hole positions

The most critical point when selecting peg hole positions is string interference®. This is one of the main reasons why

designing the Inner Lower and Outer Lower is challenging. Therefore, this issue must be considered from the design stage.

5 A phenomenon where the string of the first peg (H1) hits and bends against the second peg (H2) before reaching its own peg.
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If interference occurs, you must change the shape of the two curves or adjust the positions of the 1st and 2nd peg holes

(H1, H2).

String interference can be identified by drawing straight lines from the nut to the center of each peg hole to see if the lines
intersect. Enabling the "Peg Interrupt” item in the LAYER panel displays these lines and shows a warning message if

interference occurs.

* / ¥ H1
H1 /
/ /
/ /
+ / + /
/ /
H2 / ) H2
/ /
// / //
/ /
/ /
/ /
/ A /
+ / /’/
H3 / H3
;‘ | 1
| |
+ + [
Ha | H4 | B : ] I
\ The strings may interfere with each other. Please adjust the
\ \ peg positions.
\\ \\
— . . |
: v ze
(a) No interference (b) Interference occurs (¢) Warning message when interference occurs

Figure 17: String interference according to peg hole positions

To avoid string interference, the peg hole positions should be adjusted in a direction perpendicular to the Center Line be-
tween the Inner and Outer Lower. Typically, H1 is moved forward and H2 is moved backward. Entering a ‘+’ value moves
the peg hole toward the back of the pegbox, while a ‘-’ value moves it toward the front. However, be careful not to move
H2 too far back, as the string wound on the peg may touch the rear inner wall of the pegbox. It is advisable to pre-calculate

the minimum clearance between the peg hole and the inner wall, considering the thickness of the strings.

Among the four strings, the string for the 4th peg hole (H4) bends the most over the nut; if the angle is too extreme, it
may put stress on the string. Therefore, even if there is no interference, you might consider adjusting its position slightly

forward to reduce the bending angle.

¢ 1/2/3/4th Hole: Enter the movement distance of the peg. A ‘+’ value moves it backward, and a ‘-’ value moves it
forward.

* Space (before/after): Shows the actual distance between pegs, rather than the spacing ratio set in [K:L:M. Spacing
Ratio]. ’before’ is the spacing before adjustment, and ’after’ is the final spacing after adjustment. ’before’ always
follows the set K, L, M ratios, but the ’after’ ratio may change if the peg positions are adjusted. Since the values
reflected in the actual design are ’after’, you should readjust the [K:L:M. Spacing Ratio] if the final ratio differs
significantly from your intention. However, since the adjustment is made perpendicular to the Center Line, the

difference is usually minimal and the ratio is mostly maintained.
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Figure 18: Input values and peg movement directions

B ADJUST > Neck Curve (T-2)

Whether the Neck Curve is considered part of the head design or the neck design is debatable, but in this program, it is
defined as part of the neck design. This is because the curve can only be created once the position of the thinnest point of

the neck (Point Z) is determined. Therefore, this program assumes that the user already knows the position of Point Z.

The Neck Curve uses a cubic spline, starting from point T, passing through z3, and ending at Z. Thus, the shape of the curve
varies depending on the positions of T, Z, and z3. While T and Z are entered as coordinates by the user, the position of z3
is automatically calculated internally by the program. Points z1 and z2 are reference points generated during the process

of calculating z3. For detailed construction methods, please refer to Report :: Neck design of stringed instruments®,

 Start Angle: Sets the direction in which the curve starts at point T.
» Start Strength: Sets the intensity of the curve’s bend at point T. A larger value results in a sharper curve near point

T.

Shttps://www.hisviolins.com/post/report-neck-design-of-stringed-instruments
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4.1.5 Layer Settings

B LAYER

In the LAYER panel, you select items to display in the [Result Window] and PDF files, or to be saved. Items are grouped
and indented; only checked items will appear on the screen or be saved. While DXF files save all data regardless of the
checkbox status, unselected items are processed as ‘Layer Off”. Therefore, you must turn on the corresponding layers in

your CAD software to see the content.

* Point/Point Name: Independently displays control/reference points and their names.

¢ Scroll, Extended Scroll: Independently displays the Scroll Curve and Extended Scroll.

¢ Inner Guide/Upper/...: Independently displays sub-curves of the Inner Curve.

* Outer Guide/Upper/...: Independently displays sub-curves of the Outer Curve.

* Peg Box Guide/Peg...: Independently displays lines related to the pegbox.

¢ Neck Line/Neck Curve: Independently displays lines related to the neck.

e Chin: Displays the chin line. This is activated only for models with a chin and is selected automatically.

* Chamfer: When activated, displays the state with finished edges; when deactivated, shows the state before finishing.

e Nut: Displays the nut.

¢ Cutting Line: A simple reference line for template production.

e Other Guide: Displays horizontal and vertical lines passing through key points to serve as reference lines for
understanding the spatial relationships between parts.

* Reference Image: Displays the image specified in the [Reference Image Settings Window]. This option must be

activated when designing while comparing against an image.

H DRAW MODE
Select the update method when redrawing the [Result Graph]. (Only one can be selected)

e New: Keeps the previous result graph as is and displays the new one in a new window.
* Redraw: Clears the previous design and displays the new design.
* Overlap: Does not clear the previous design and displays the new design on top of it. This is used to overlap and

compare different designs.
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4.1.6 Calculation and File Saving
B Calculate & Draw

Calculates the curves based on the input values and displays the design results on the screen.
H Save to Files

Saves the completed design as PDF, DXF, and TXT files.

Files are generated in the folder where the program executable (Violin_Head_Designer_v.X.X.X.exe) is located,

and the filenames are recorded in the format [New_Head_Design_yyyy-mm-dd_hh-mm-ss. XXX].
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4.1.7 Additional Features
M File > Import

You can load a previously saved settings file to immediately restore the same design. Click [File > Import] in the [Main
Window] to load the settings file. After loading, press [Calculate & Draw] to display the design on the screen, and use
[Save to Files] to output PDF, DXF, and TXT files.

M File > Export

Once the design is complete, click the [File > Export] button in the [Main Window] to save all current settings to a file.

The saved file can be reloaded later using the [Import] function.

% Reference images and related settings are also saved within the settings file.
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4.2 Result Window

This is the [Result Window] that appears when you click the [Calculate & Draw] button in the [Main Window]. All content

displayed on the screen can be saved as PDF, DXF, and TXT files. The visibility of each item is configured in the LAYER

panel of the [Main Window].

H Bottom Buttons
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Figure 19: Result Window

At the bottom of the [Result Window], there are several functional buttons for operations such as panning and zooming.
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4.3 Reference Image Settings Window

This window is used for designing based on instrument photos or for tracing an actual object.

It is accessed by clicking [Tools > Reference Image] in the top menu of the [Main Window]. After loading a prepared

photo, you can adjust its position and size. It also includes buttons for measuring instrument dimensions and allows for

the setting of reference lines.

| @ Reference Image Setting

* Select Image Browse.. | l

* Height of Image [mm] 0.00 ™ Flip Horizontal Image

* Set Image Origin « click button, then click on image
I Horizon Line-1 (mm): 0.00 @ @ @ m
™ Horizon Line-2 (mm): 0.00 @ @ @ m
I Horizon Line-3 (mm) : 0.00 E @ @ m
| I Vertical Line-1(mm): 0.00 @ @ @ m |
I Vertical Line-2 (mm) : 0.00 E @ @ m ‘
I~ Vertical Line-3 (mm) : 0.00 @ @ @ m
I~ Angle Line-1("): 0.00 E @ @ m
L Move (y-Axis) [mm] : 0.00 @ @ E}l E’l |
= OOEE DEEE
| * Rotate Image m m E ﬂ
| * Zoom Image = -

4' CIear A“

Figure 20: Reference Image Settings Window

Select Image: Button to upload a reference image.

Height of Image: Specifies the total vertical size of the image displayed on the screen. Since work must be done
at a scale identical to the actual object, it is best to enter a value close to the actual size. For example, if the head
length is 105mm and the top/bottom margins of the photo are 20mm each, enter 145 (the total). You can fine-tune
this later with the zoom function, so an approximate value is fine initially.

Set Image Origin: Specifies the end of the fingerboard as the origin (0, 0) of the reference image. When the mouse
cursor changes after clicking the button, you can select the desired point to set it as the origin.

Horizon Line-1/2/3: Horizontal reference lines for height comparison. Activating the checkbox and entering a
value displays a horizontal line at that position.

Vertical Line-1/2/3: Vertical reference lines for width comparison. Activating the checkbox and entering a value
displays a vertical line at that position.

Angle Line-1: A slanted line for referencing the chin inclination of cellos and violas. Activating the checkbox and

entering a value displays a slanted line passing through the origin.
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* Move (y-Axis): Moves the slanted reference line along the Y-axis.

* Move/Rotate/Zoom Image: Moves, rotates, or zooms the reference image.

¢ Measuring A X: Measures the X-axis distance between two points on the reference image. When the cursor changes
after clicking the button, select two points to check the distance.

¢ Measuring AY': Measures the Y-axis distance between two points on the reference image. Usage is the same as the
X-axis measurement.

¢ Measuring A D: Measures the straight-line distance between two points on the reference image. Usage is the same
as the X-axis measurement.

* Draw Image: Displays the [Reference Image Result Window] on the screen.

* Reset Image: Reverts the moved, rotated, or zoomed reference image to its initial state.

* Clear All: Deletes all settings, including the image.
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4.4 Reference Image Result Window

This screen appears when you click the [Draw Image] button after loading an image in the [Reference Image Settings
Window]. You can use this window to adjust the position and size of the image in real-time. If reference lines are activated
in the settings window, they will be displayed at the corresponding positions. For workflow convenience, reference images

are always converted to greyscale even if the original is in color.

When performing detailed work while zooming or moving the image, it is convenient to use the control buttons at the

bottom of the result window.
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Figure 21: Reference Image Result Window
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4.5 Point Guide Window

This is a guide image that allows you to check the positions of the main points used in the program at a glance. It appears

when you click [Tools > Point Guide] in the top menu of the [Main Window].

? Point Guide = [m] X

Figure 22: Point Guide Window
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5 Actual Usage and Procedure

This section explains the actual workflow for precisely copying an existing violin head. This process can also be used as a

basis when modifying a model or creating a new design.

The overall workflow and order are as follows:

1. Start
Run the program and, in the [Main Window], enter the model name > select a preset > then click Tools > Reference

Image.

2. Upload Reference Image

In the [Reference Image Settings Window], load an image, enter the image size, and click the [Draw Image] button.

3. Adjust Reference Image
Adjust the image rotation and scale, and set the origin. Measure distances for each part if necessary, then close the

settings window.

4. Curve Settings and Result Verification
Click the [Calculate & Draw] button in the [Main Window]. While checking the displayed result screen, modify the
input values for GEOMETRY, CURVES, and ADJUST.

5. File Saving
Click the [Save to Files] button to save the design results, and use [File > Export] to separately save the current

settings file.
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6 Development and Operating Environment

This software is for “Windows OS.” It was developed in a “Python 3.10 + Tkinter” environment and has been verified to

work only on “Windows 11”.

Reference Site

H.LS. Violin Atelier — https://www.hisviolins.com

Copyright © 2026 Hwang, I1-Seok. All rights reserved.
Unauthorized modification and commercial sale are prohibited.
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